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About the Author 

 

Esther Friedberg Karp is an internationally renowned trainer, writer, business consultant and speaker 
who has been repeatedly listed as one of Insightful Accountant’s Top 100 QuickBooks ProAdvisors 
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behalf of their own clients. She is sought out for her expertise in multicurrency and various countries’ 
editions of QuickBooks Desktop and Online, and for her talent in customizing QuickBooks usage for 
different industries. She also teaches QuickBooks Core and Advanced certification classes to 
accounting professionals in Canada. 

Esther holds a BSc from the University of Toronto in Actuarial Science and Mathematics, and an MBA 
in Marketing and Finance from York University’s Schulich School of Business.  

She can be reached at esther@e-compubooks.com or 416-410-0750. 

 

 

Esther Friedberg Karp, MBA  

President, EFK CompuBooks Inc. 

esther@e-compubooks.com 

mailto:esther@e-compubooks.com
mailto:esther@e-compubooks.com


Lesson 12 —Payroll with QuickBooks Lesson Objectives 

QuickBooks Desktop 2021 Client Training 5 

Lesson Objectives 

• Gain an overview of payroll in QuickBooks 

• Learn more about payroll setup 

• Set up employee payroll information 

• Set up payroll schedules 

• Practice writing and printing a payroll check 

• Learn how QuickBooks tracks your tax liabilities 

• Practice paying payroll taxes 

 

 



Lesson 12 —Payroll with QuickBooks Setup for Payroll 

QuickBooks Desktop 2021 Client Training 6 

Setup for Payroll 

Keep in mind you must subscribe to one of the available QuickBooks Payroll services that work with 
QuickBooks Desktop in order to run payroll in QuickBooks. However, you can test the features of 
QuickBooks Payroll using one of the sample companies such as Rock Castle Construction. Do not 
use this feature for actual payroll as the rates are not accurate. 

If you want to turn on or off payroll in a company file, follow the procedure below.  

 Step-by-Step: Turn Payroll Off in a Company File 

1. Make sure you are signed into the QuickBooks company as the Admin user. (If other users have 
been set up on other computers to access the company in multi-user mode, ensure they are not 
signed in and you are in single-user mode.) 

2. From the Edit menu, choose Preferences  Payroll & Employees in the left panel. 

3.  To turn payroll off, click the Company Preferences  No payroll. To turn payroll on, in the 
same tab, select either Full payroll or Online payroll. If you are issuing paychecks but the 
calculations are manual in nature, click Manual Payroll. You will see a pop-up menu indicating 
the benefits of QuickBooks Payroll Services. (If you turn on payroll, you will be able to select the 
subscription of your choice from the Employees menu  Payroll Center  Payroll Setup.) 

4. Click OK. 

QuickBooks maintains a list for everything that affects the amount on a payroll check and for every 
company expense related to payroll. This list is called the Payroll Item List. There are payroll items for 
compensation, taxes, other additions and deductions, and employer-paid expenses. QuickBooks 
uses payroll items to track individual amounts on a paycheck and accumulated year-to-date wage 
and tax amounts for each employee. 

Payroll items affect either Payroll Liabilities or Payroll Expenses on the Chart of Accounts by default 
(unless you make changes to their setup). However, you will be able to run detailed reports related 
to payroll based on the payroll items and how they are used in paychecks and payroll liabilities 
payments. 
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 Step-by-Step: View the Payroll Item List 

1. From the Employees menu of a QuickBooks sample company, choose Manage Payroll Items  
View/Edit Payroll Item List. You can also access this list from Lists  Payroll Item List. (You 
must have payroll turned on to see this choice in an actual company.) 

 

2. Close the Payroll Item List. 

NOTES 
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If you need to add a payroll item after you’ve set up payroll in QuickBooks, use the following 
procedure. 

 Step-by-Step: Add a Payroll Item 

1. From the Employees menu, choose Manage Payroll Items  New Payroll Item. (You can also 
access this from the Payroll Item List by selecting the Payroll Item button at the bottom and 
selecting New.) 

2. Select Custom Setup  Next. 

3. QuickBooks displays the Add new payroll item window, which walks you through the payroll item 
setup process. 

 

4. Select the type of payroll item you want to create, then click Next. 

5. Follow the onscreen instructions to create the payroll item. 

6. When you are done click Finish. 

7. Close the Payroll Item List. 

NOTES
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Set Up Employee Payroll Information 

QuickBooks calculates payroll for each employee based on that employee’s pay rate, marital status, 
exemptions and so on. The Employee Center stores general information about each employee, as 
well as payroll information. 

 Step-by-Step: View Information Stored in the Employee List 

1. Click Employees  Employee Center in the menu bar to open the Employee Center.  

2. Click the Employees tab in the left section. 

3. Select the employee you wish to view, then right-click and select Edit Employee. 

4. Click the Address & Contact tab to enter the employee’s address, phone number and 
emergency contact details. 

5. Click the Additional Info tab to access the employee ID or account number, billing rate level 
and custom fields. 

6. Click the Payroll Info tab to set up the employee pay schedule, additions, deductions and 
company contributions.  
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7. Use the buttons on this tab to access additional information for direct deposit, taxes and 
sick/vacation pay. 

 

8. Click the Employment Info tab (for employment dates and details, leave of absence information, 
and termination details if applicable) and the Workers’ Comp tab (to assign the Workers’ Comp 
Code). 

9. Click OK to save your changes and to return to the Employee Center. 

NOTES
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Use Employee Defaults to Store 
Common Information 

QuickBooks stores a wealth of information about each employee, but it doesn’t require you to enter 
the same information over and over. When you have information that applies to most of your 
employees, you can enter it into your employee defaults. Then when you add an employee, 
QuickBooks automatically fills in the information stored with those employee defaults. You will need 
to add or change any information that is different for a particular employee. 

 Step-by-Step: View Employee Defaults 

1. From the Employee Center, choose Manage Employee Information  Change New 
Employee Default Settings. 

 

2. Set the default pay schedule, earnings items, etc. from the window. 

3. Click Taxes to set up the default state/federal tax settings. 

4. Click OK to close the Taxes Defaults window. 

5. Click Sick/Vacation to modify the default settings, then OK to close it. 

6. Click OK to close the Employee Defaults window. 
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Set Up Payroll Schedules 

You can set up payroll schedules to group employees with the same pay frequency (daily, semi-
monthly, bi-weekly, monthly, quarterly, and annually). You define how often you pay your 
employees, which date their paycheck is due and which day you run payroll. QuickBooks calculates 
your upcoming payroll schedule so you can pay your employees on time.  

Using payroll schedules is a quick and convenient way to pay your employees each pay period. You 
set up the payroll schedule one time, assign the payroll schedule to the appropriate employees and 
QuickBooks calculates the due dates for each upcoming pay period. 

You do not need payroll schedules to run payroll, however. You can run payroll without them by 
running Unscheduled Payroll or paying an employee a termination check. 

 Step-by-Step: Define a Payroll Schedule 

1. From the Employees menu at the top, choose Add or Edit Pay Schedules.  

2. Click the Payroll Schedule menu button at the bottom left, then choose New. 
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3. Enter a name for your payroll schedule in the What do you want to name this payroll schedule? 
field. 

4. Press Tab and select the pay frequency. 

5. Press Tab and select the pay period end date for the next period you wish to run payroll. 

6. Press Tab and select the date that should appear on the checks for the next period you wish to 
run payroll. 

7. Press Tab and select the day that should appear on the checks for the next period you wish to 
run payroll. 

8. Click OK. 

9. You’ll see a confirmation that the payroll schedule you just created has been set up. Click OK. 

10. Repeat as needed to set up your pay schedules. 

11. Close the Payroll Schedule List. 
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Now that you’ve set up the pay schedules, you can assign each employee to the appropriate pay 
schedule. 

 Step-by-Step: Assign a Pay Schedule 

1. From the Employees menu, choose Employee Center. 

2. Click the Employees tab in the left section. 

3. Right-click the employee you wish to assign a pay schedule to, then select Edit Employee. 

4. In the Edit Employee window, choose the Payroll Info tab. 

5. From the Payroll Schedule drop-down list, select the pay schedule you wish to assign. 

6. Click OK. 

7. Repeat the steps for each employee to assign the proper pay schedules. 

NOTES
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Add a New Employee 

 Step-by-Step: Add a New Employee 

1. With the Employee Center displayed, click New Employee at the top left in the Employees tab. 

2. Enter the corresponding information in the Personal, Address & Contact and Additional Info 
fields. 

3. In the Payroll Info tab:  

 From the Payroll Schedule drop-down select the schedule required 
 Choose the earning items that apply to this employee in the Earnings grid (e.g., salary, 

hourly, overtime, etc.) 

 Choose any items that apply to the employee from the Additions, Deductions and Company 
Contributions grid 

 Click the Direct Deposit button to set up direct deposit information 

 Click the Taxes button to set up federal withholding and state tax information 

 Click the Sick/Vacation button to add any sick/vacation time accrual information 
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 IMPORTANT: If you would like the time automatically entered from timesheets, place a check in the box 
labeled Use time data to create paychecks. 

 

4. Enter remaining information in the Employment Info and Workers’ Comp tabs. 

5. Click OK. 

NOTES
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Run a Payroll Schedule 

QuickBooks lets you print payroll checks in a batch based on payroll schedules.  

 Step-by-Step: Run a Payroll Schedule 

1. In the Employee Center, click the Payroll tab in the left section. 

2. In the right section, click the Pay Employees tab. 

3. In the Pay Employees section, choose the Biweekly pay schedule. 

4. Click the Start Scheduled Payroll button. (If the Special Paycheck Situation window pops up, 
click Continue.) 

5. Specify the pay period, check date and bank account from which paychecks will be produced, 
and if the checks are to be printed or handwritten. If they are handwritten, specify the first check 
number. 

 

6. If you receive another Special Paycheck Situation window, click Continue. 
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7. Select the employees you wish to pay by ensuring there is a checkmark next to their name in the 
grid. 

 

8. Click Continue. You may get a warning about one or more paychecks not having an assigned 
class. Click OK. 
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9. To review all paychecks, click the Open Paycheck Detail button or, to review one paycheck, 
click the employee’s name in the grid. 
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10. If you clicked Open Paycheck Detail you are reviewing the paychecks one at a time; click Save 
& Next to review the next paycheck. 

 

11. Once you’ve reviewed all the paychecks you wish, click Save & Close on the paycheck(s) to 
return to the Review & Create Paychecks window. 
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12. Click Create Paychecks. 
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QuickBooks creates a payroll check for each employee in the chosen payroll schedule for the 
correct net amount, showing the deductions in the voucher area. QuickBooks confirms you have 
created the paychecks. You can then choose Print Paychecks (or Print Pay Stubs if they are 
going to be handwritten checks). 

 

13. If you don’t want to print the paychecks now, click Close. 

NOTES
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View the Paycheck 

QuickBooks records payroll checks in your QuickBooks bank account register (whichever bank 
account you selected when you started to pay these employees). You can see the check by going to 
the register and opening it the way you open any transaction in a register, but it is easiest to view 
employee checks from the Employee Center. 

 Step-by-Step: View the Paycheck from the Employee Center 

1. From the Employees drop-down menu, click Employee Center. 

2. Click the Employees tab in the left section if it isn’t already selected. 

3. Select the name of the employee whose paycheck you want to view.  

4. You’ll see a list of recent paychecks for that employee in the Transactions tab in the right section 
of the Employee Center. Double-click the paycheck you want to open from the employee’s 
transaction list. 

 

5. Click Save & Close to close the paycheck. 
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Print Paychecks after Leaving Pay Employees 
Window 

You can print paychecks (that were selected as Print paychecks on check stock in the Review and 
Create Paychecks window rather than Handwrite & Assign check numbers) after creating them while 
still in the Pay Employees area. However, you do not have to print them at that time. You can close 
the payroll function and print them at any time. 

You print paychecks similarly to other QuickBooks checks. If you use voucher checks, QuickBooks 
prints the payroll item detail in the voucher area. If you don’t use voucher checks, you can print a pay 
stub to give to your employees. 

 Step-by-Step: Print Paychecks after you Exit the Pay Employees Window 

1. From the File menu, choose Print Forms  Paychecks. 

2. Select the bank account that is the source of the paychecks from the Bank Account drop-down. 

3. In the First Check Number field enter the starting check number from the check stock on which 
you are printing. 

4. Make sure there’s a checkmark next to all employee names whose paychecks you are going to 
print, and then click OK. 
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5. If desired, enter the text for a company message to appear on all pay stubs. 

6. Click Print. 
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Print or Email Pay Stubs after Leaving Pay 
Employees Window 

You can print pay stubs after recording paychecks that are to be handwritten while still in the Pay 
Employees area. However, you can close the payroll function and print or email them at any time. 

 Step-by-Step: Print or Email Pay Stubs after You Exit the Pay Employees 
Window 

1. From the File menu, choose Print Forms  Pay Stubs. 

2. Select the bank account that is the source of the paychecks from the Bank Account drop-down. 

 

3. Specify a date range for listing pay stubs. 
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4. In the Employee drop-down, make sure All Employees is selected or, if desired, specify one 
employee, so you can find the employee(s) for whom you wish to print one or more paystubs.  

5. Place a checkmark next to the employees’ paychecks for which you want to print or email a pay 
stub. 

6. If desired, enter the text for a company message to appear on all pay stubs. 

7. Click Print or Email. If you chose Email you will see a Paystub Information screen. Click OK. The 
Password Protection screen appears. Read the information and click OK. Follow the prompts to 
complete any missing employee email addresses. 

 

8. You’ll see an Email Security window appear. Click OK. 

NOTES
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Pay Payroll Taxes 

If you’re about to pay taxes or other liabilities, the Payroll Liabilities Balances report shows how much 
to pay. Suppose you are ready to make a tax payment and you want to see how much you owe. 

 Step-by-Step: Create a Payroll Liabilities Report 

1. From the Reports menu, choose Employees & Payroll  Payroll Liability Balances. 

2. Select This Calendar Year in the Dates cell. 

3. Click the drop-down menu in the Show Columns section at the top of report, then select Year 
(as opposed to Month, which was the default displayed when this report first appeared) to 
change the report display. 

 

4. Close the report. 

NOTES
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Write a Check for Payroll Taxes 

When it’s time to deposit payroll taxes with your deposit institution, use the Liability Check window 
to fill out a special type of QuickBooks check for this purpose. 

 Step-by-Step: Pay Payroll Liabilities 

1. From the Employees drop-down menu, choose Payroll Taxes and Liabilities  Create Custom 
Liability Payments. 

2. In the From and Through fields, enter the date range for which you are paying the liabilities. 

 

3. Click OK. 

4. Complete the information in the Pay Liabilities window to mirror the payment you making: 

 Ensure the proper Bank Account is selected 

 Enter the proper Check Date 
 Place checkmarks next to the liabilities you wish to pay; normally, you’d select all liabilities 

that are for one Payable To name 
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5. Make sure Review liability check to enter expenses/penalties is selected, then click Create. 
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QuickBooks will create one liability check per institution.  

6. Click Save & Close to record the check. 

NOTES
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Payroll with QuickBooks — Review Questions 

1. What is required for QuickBooks to calculate payroll in a real company file?  

_______________________________________ 

2. Which two accounts are typically linked to payroll items? 

a. ___________________________________________________________________ 

b. ___________________________________________________________________ 

3. Which of the following are QuickBooks payroll item types? 

a. Wage 

b. Addition 

c. Deduction 

d. All of the above 

4. What report would you run to determine how much you owe in payroll taxes? 
________________________________________ 

5. What QuickBooks feature would you use to make setting up payroll easier when a number of 
employees have the same hourly wage, pay period and base deductions? 

a. Tax tables 

b. Employee defaults 

c. Payroll items 

d. Assisted payroll 

6. True or false: Payroll schedules are required to run payroll in QuickBooks. 

a. True 

b. False 
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7. Payroll schedules help you do which of the following? 

a. Group employees with the same pay frequency 

b. Write bonus checks 

c. Prepare termination checks 

d. Pay payroll tax liabilities 
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Review Activities 

Use Rock Castle Construction (sample product-based company) to do these activities: 

1. Add a salaried employee to the Employee Center. Enter the employee’s personal information, 
federal and state tax information, and at least one additional paycheck deduction. Assign the 
employee to the monthly payroll schedule. 

2. Run the monthly payroll schedule and process a paycheck for the new employee. View the check 
in QuickBooks. Open at least one payroll liability account register to see how the paycheck 
changes the account’s balance. 

3. Select one of the Payroll Expense accounts from the Chart of Accounts. Create a QuickReport for 
that expense account. 
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Answers to Review Questions 

1. What is required for QuickBooks to calculate payroll in a real company file? 

A subscription to a QuickBooks payroll service 

2. Which two accounts are typically linked to payroll items? 

a. Payroll Liabilities 

b. Payroll Expenses 

3. Which of the following are QuickBooks payroll item types? 

a. Wage 

b. Addition 

c. Deduction 

d.  All of the above 

4. What report would you run to determine how much you owe in payroll taxes? 
Payroll Liabilities Balances 

5. What QuickBooks feature would you use to make setting up payroll easier when a number of 
employees have the same hourly wage, pay period and base deductions? 

a. Tax tables 

b.  Employee defaults 

c. Payroll items 

d. Assisted payroll 

6. True or false: Payroll schedules are required to run payroll in QuickBooks. 

a. True 

b.  False. You do not need payroll schedules to run payroll. You can run payroll without them 
by running Unscheduled Payroll or paying an employee a termination check. 
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7. Payroll schedules help you do which of the following? 

a.  Group employees with the same pay frequency 

b. Write bonus checks 

c. Prepare termination checks 

d. Pay payroll tax liabilities 
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